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Introduction

This manual describes briefly the use of MacBeads 1.01. Please read it before pitching in -

there are some things which might otherwise cause you some problems.

MacBeads 1s a program which enables the user to build 3D spatial models composed of
spherical beads. When a satisfactory model has been built, then a text file output can be
requested which gives the size, 3D coordinates and number of all the beads selected.
Relevant details of the total model (name, mass, partial specific volume) can also be stored in
the same file in a ‘tailpiece’ Alternatively, a model can be input from a suitably formatted
text file produced from crystallographic co-ordinates by a program such as AtoB (Olwyn
Byron). MacBEADS models can also be plotted and manipulated in 3D space (APPENDIX)

Basic Philosophy of MacBeads
MacBeads has two primary uses:

(1) given some sort of preliminary, low resolution model of a macromolecular structure,
MacBeads enables that structure to be mapped out in space as an assembly of
spherical beads. The low resolution model might, for example, derive from EM or
LAXS data. Programs such as HYDRO (Garcia de la Torre) can evaluate
hydrodynamic parameters (frictional coefficient, diffusion & sedimentation
coefficients, intrinsic viscosity) from such bead models. They require that the details
of the size and (x,y,z) locations of each bead be specified in a suitably formatted text
file. MacBeads produces text files containing this data for the model which has been

built by the user.

(i1) given an existing bead model, for example derived from crystallographic coordinates,
MacBeads provides a convenient way of ‘bending it around’” - i.e. making
adjustments to relative orientations of major domains, to probe the effect of so doing
on hydrodynamic parameters. An example of this can be seen in the work on the

flexibility of the myosin head in Bayliss et al (1999).

The present Manual concentrates on the first of these uses, as the principles of the use of the
program are identical in either case. A familiarity with the normal use of menus etc and with

simple graphics operations (e.g. dragging and marqueeing) within the Mac OS is assumed.



How models are built
The definition of a bead

A bead is a single spherical entity of defined radius with its center located at defined (X,y,z)
coordinates. Generally the user of MacBeads will have specified the radius such that the
molecular mass is defined via an experimentally known or computed partial specific volume
(vbar). This is done either from first principles or by making use of a general hydrodynamic
utility suite (e.g. BIOMOLS from the NCMH). Clearly if n beads are to be used to model a
particle (e.g. a protein domain) then the sum of the mass of the n beads should be equal to the

known mass of the particle.

Beads are created located and duplicated as needed via the Bead Menu (p. 5). Any individual

bead is selected by ‘clicking” on it, when a ‘handle’ appears within the bead:

The bead on the right hand end of this row of 3 1s the one selected. You can select more than
one bead either by ‘shift clicking” on the desired beads, or by marqueeing the same. You can
then deselect any given selected bead by ‘shift clicking” it. Note: a newly created bead 1s

always 1n ‘selected” mode.

You can OPEN any bead by double-clicking on same (or by selecting it and using the OPEN
BEAD function, p. 5). The bead is ‘greyed’ and a dialog box appears:
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You can then modify the bead details as required. Note: you must exit from this dialog box
by clicking on either OK or Cancel or Close Dialog Boxes — not by clicking back onto any
other window ! {if you accidentally do that — re-open the bead and exit properly . . . }

You may also modify the size property (radius) of an individually selected bead by simply
getting hold of its handle and enlarging or reducing it by dragging.

The three coordinate planes

MacBeads display 3 windows which give the view of the assembly of beads which you have
created in the 3 coordinate planes (YZ, ZX, XY). You will be asked to specity the (z,y,z)
coordinates of each bead which you create. You can select which view you require either by

use of the View Menu (p. 6) or by simply clicking on the required window.
How beads are moved in space

You do not need to make a decision as to where a newly created bead should be finally
located at the time of its creation. You can, for example, create all beads at some reference
position, and then either drag them to the position desired, or use the translate function
available from the Transform Menu (p. 6). Dragging works fine of course with any given

selection of beads — or with your whole model, selected by marqueeing everything.
Working with built or part-built models

The ability to select either the whole or a part of a model (by marqueeing or by shift-
clicking) means that it 1s easy to manipulate the orientation of whatever is selected, whilst
leaving any unselected regions unchanged. Moreover, the four very useful functions
contained in the Transform Menu (p. 6) mean that one can opt to work on your model (or a
part of 1t) in any plane — not just the 3 principal planes — by simply rotating it in any desired

way until the plane to be worked on coincides with a principal plane.



The use of the Menus in MacBeads

The functionality provided by the various Menu functions are a central, powerful feature of

MacBeads. These are described below, in order (L to R) as they appear in the Menu Bar:
File

These are standard Apple File Menu functions — but note the Save as Text command which

enables you to save the output details of your model
Edit
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This again resembles the standard Apple Menu — except that there is now a Set Tailpiece
option. You us this to enter the name etc of your model, and the details entered will appear in

your final output file.
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This Menu enables you to create beads. New Bead creates a new bead, with a dialog box
enabling you to specily size and location. Old Bead creates a new bead identical to the last
one created. Open Bead 1s a (little used) alternative to double-clicking. You must have

selected a bead (by single clicking) before use of this command.
The Close All Dialogs command 1s here (well, it had to go somewhere).

All these commands have keyboard equivalents.



Transform
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These four commands, with the relevant dialog boxes, provide a comprehensive set of tools

for manipulation of models. They do exactly what their names say they do.
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The Set Scales option allows you to set the relationship between the bead dimensions (in A)
and the scale within the document, as printed at 100%. The Zoom options are self-defining
(and have keyboard alternatives). The Show Window Info command is so useful to remind
you as to which axis goes in which direction that it i1s generally advantageous to keep it

‘switched on’ all the time (standard convention — it’s ‘on” when it’s ticked).

The use of the three commands to view the individual principal planes is useful to avoid

‘clicking around” on the screen.
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This Menu enables you to allocate a distinctive pattern to any bead or set of beads. Simply
select the beads to which you wish to allocate a pattern, and then select the desired pattern

from this Menu.

You can, if you wish, make this palette into a ‘floating palette’. Simply ‘grab’ the palette by
one of its patterns (in the example shown above, the top left pattern has been ‘grabbed’) and

drag it to where you would like it to be:

In the examples shown above, all beads have been selected and filled in with pattern white
(LEFT) whilst on the RIGHT we seen the result of successively selecting two of the beads

and giving them an individual pattern.

This option is useful for identifying individual parts (e.g. those denoting protein domains)

within a total structure.
Help

This is the standard Apple Balloon Help command — it does not contain any MacBeads

specific options.



Output

Models may be saved using the File Menu in the normal manner. The ultimate output for
further interpretation is obtained using the Save as Text command from the File Menu. This
produces a text file which can be opened and if need be edited in any application (MS-
WORD, whatever) capable of handling text.

You can also OPEN the text output within EXCEL, specifying that it is comma delimited

(see the technical notes below). This is obviously useful for sundry further manipulations.

The output (in MS-WORD) looks like this

'rial'’
ZE
1. 152 2., cl.6.; o_o. lo._n
2. 1737, 15.1; o_o,; lz.5
2. Zol.4., l1a._3., a_o, 15._0
g, P 15 5. o_o. lo._n
L 136 .2, a0 _9. o_o. lo._n
[ 1555, S9._7. o_o. lz._5
7. 175.9, a0 .3, o_o. 150
[ 137.7, Qz_.1; o_o,; lo._0
9. 1zs.0, z22.6, a_o, 15._0
1o, 3.5, 12 2. o_o. 150
11. g3 3. -T2, o_o. 150
1z, T1.6. 2.1, o_o. 150
1z, -69.32, -35 .2, o_o. 150
13, -31.2,; -25.0, o_o,; ls.0
15, =12.0, -27.7, a_o, 15._0
16, 15 2. -17.5, o_o. 150
17. -Z25.5, =1lo032_7. o_o. 150
15, -zlo.z, -93_5, o_o. 150
17, -97.5,; -55.3, o_o. 150
ol 1 -1l25.7, —65.7T, o_o,; ls.0
z1. -1sz.1, -59.Z, a_o, 15._0
2E . -1l52.9., -72.0, o_o. 150

<= n-

<z n-

'Crame>!

<ud

<molecunl ar weight>
<partial specific wolume>
1.0=-03

The file starts with the name of the model and the number of beads, and then for each beads

lists the 3 coordinates followed by the radius. The “tailpiece’ information is appended.
Getting started

A simple demonstration file is attached, as well as a copy of the myosin S1 model. Have a go

with these, as well as trying to set up a basic model from scratch.



Some additional technical details

These are some programmer’s notes which take some of the issues raised above a little

further, and may be helpful to users.
Output Format

MacBeads creates a text file output suitable for submission to a particular computer package.

It should be only a small job to modify these files for other end-software ..

The most likely problem is the end-of-line character. The Macintosh convention is to
terminate lines with a return character (ASCII 13) and this is the convention followed.
Another commonly used convention (used by UNIX and MS-DOS amongst others) is to
terminate lines with a linefeed character (ASCII 10). You can use a search-and-replace
facility like Word’s to exchange things round. You just may need to modify the separator

between items on a single line.
Shift-Clicking:

Shift-clicking an unselected bead selects it without otherwise changing the current selection.
Shift-clicking a selected bead deselects it without otherwise changing the current selection.

Shift-clicking an open bead has no effect.
Double-Clicking

Double-clicking an unselected bead clears the current selection and then opens the bead.
Double-clicking a selected bead opens the entire selection, not just the bead. Double-clicking

an already open bead brings the bead’s associated dialog to the front.
Marqueeing

Marqueeing clears the current selection and then selects all beads completely enclosed by the

marquee rectangle. Open beads are unaffected.
Shift-Marqueeing

Shift-marqueeing selects all unselected beads completely enclosed by the marquee rectangle
and deselects all selected beads completely enclosed by the marquee rectangle. The current

selection is otherwise unaffected. Open beads are unaffected.



Dragging (or Shift-Dragging)

This moves the entire selection around. The movement 1s constrained to a plane determined

by the currently active window.
File Menu
Most of the commands 1n this menu work as you would expect. The only things to note are:

The Open command allows you to open both text files and files in the native MacBeads
format . Naturally although you can attempt to open any text file, only those that contain the
correct information will open successfully. Text files created by MacBeads (via the ‘Save As

Text” command) will open correctly but this may not be the case for other TRV files.
Edit Menu
Again these commands mostly work as you would expect. The exceptions are:

Having cut or copied some beads they can be pasted back into the MacBeads document, into
any other MacBeads document or into a document of any other application that can work
with the PICT format. If you paste into a MacBeads document, you are prompted for the
location in three dimensions at which you want the new beads pasted. Only one paste dialog
can be open at any time. If you paste into any other document all you get is a two
dimensional image of the beads (editable in Appleworks PT etc.), the projection being

determined by the active window when the beads were Cut/Copied.

The ‘Set Tailpiece’ command allows you to enter a string that will be appended to all output
text files. The string can include return characters. Clicking on OK in the dialog sets the
tailpiece of the active document. Clicking on Set Default sets the tailpiece for all new

documents you may subsequently create.
Bead Menu

The ‘Open Bead” command creates a modeless dialog showing the coordinates and radius of
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